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1.0 Introduction
Overview
This guide describes how to setup and use VWMS, 3M’s network device management application that
helps you manage 3M’s VOL-0215 Ethernet switches. The VWMS application runs from a web server
located in every managed 3M switch. VWMS provides a friendly, easy-to-use GUI that helps you optimize switch performance. You can increase network security by designating managers, blocking devices
from accessing certain ports, and defining VLANs. VWMS provides status reports regarding Spanning
Tree, traps, and connected stations. VWMS also gives convenient access to SNMP, and provides simple
control of unit reset, polling, and passwords. VWMS-Java is accessed via any standard browser such as
Netscape Navigator™ or Microsoft Internet Explorer™. VWMS-WIN is accessed via Castle Rock
SNMPc™ network management system and VWMS-WIN-OV is accessed via HP Open View™ Network
Node Manager. VWMS-Java and VWMS-WIN are very similar, and differences between them are noted
in this guide where appropriate.
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2.0 Configuring Initial Parameters with the Terminal
Overview
This section describes the unit's console configuration program. This program allows you to configure the
basic IP parameters necessary before you can manage the unit using VWMS This section contains the
following sections:
Getting Started with the Terminal - Describes how to set up the terminal, enter your username and
password to access the menus, navigate the menus, and save your changes.
Quick Terminal Configuration - Describes how to quickly assign the most basic IP parameters so you
can configure the unit via VWMS.
Terminal Configuration Menus - Describes each option in the main menu and the submenus in the order
they appear. The submenus include the IP Configuration menu, and SNMP Configuration menu.

2.1 Getting Started with the Terminal
This section describes how to set up the terminal, enter your username and password to access the menus,
navigate the menus, and save your changes.

2.2 Setting Up the Terminal
To access the unit's terminal configuration program, you must attach a terminal to the unit and setup the
terminal as follows:
1. Connect the special RJ-45 serial cable to the Console connector on the front panel. The other end of
the cable should be connected to a standard VT-100 or compatible terminal, or a terminal emulator.
Cable length should not exceed 10 meters. For cable pin-out refer to the unit's User Guide.
2. Verify that the terminal is set to 9600 baud, 8 data bits, 1 stop bit, no parity, no flow control.

2.3 Entering Username and Password
When your terminal is connected to the unit and the unit is powered-up, you are prompted for a username
and password.
Type volition for the username, and press Enter for the password, the main menu will be displayed.
Optionally, you can add a password later (refer to General Configuration Menu on page 6).

2.4 Navigating the Menus
Use the following keys to navigate the menus:
To view a submenu...>

Type the number of the menu.

To edit an option...>

Type the number of the option.

To finish editing an option...>

Press Enter.

To return to the main menu...> Press Esc or type the number 9.

2.5 Quick Terminal Configuration
Before you can configure the unit via VWMS, you must set several IP parameters using the terminal. This
section describes how to set these parameters.

2.5.1 Setting Basic IP Parameters
The basic IP parameters that must be set before you can access the unit via VWMS are located in the
General Configuration menu. The parameters are:
Agent IP Address - The IP address identifies the unit on the network. The IP address must be unique, and
should be typed in standard dot notation. For example, 192.115.16.131
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Agent Netmask - IP addresses consist of a network portion and a station portion. The Netmask defines
the size of the network portion of the address, and the remaining part is the station portion.
Default Gateway - The IP address of a network device that performs the gateway function. Packets with
unknown addresses are sent to the gateway, and the gateway forwards them to their destinations on other
subnets. The gateway device must be on the same subnet as the unit, so the network portion of their IP
addresses should be identical.
To set the basic IP parameters of the unit:
1. From the main menu on the terminal, type 1 to enter the General Configuration menu.
2. Set the Agent IP Address, Agent Netmask, and Default Gateway as described above.
3. Press Esc to return the main menu.
You may now configure the unit using VWMS. Refer to Section 3: Installing and Opening VWMS.

2.6 Terminal Configuration Menus
The unit's terminal configuration program options are organized in menus as described below. Almost all
options are also accessible via VWMS.

2.6.1 Main Menu
The Main menu of the unit's terminal configuration program contains the following options:
General Configuration - This submenu contains in-band communication parameters for SNMP and Web
communication with the unit. The submenu also includes password configuration.
SNMP Configuration - This submenu contains parameters that allow the unit to report to a management
station.
Ports Configuration - This option allows the user to configure each port's status. i.e. enable/disable port,
set port to half/full duplex etc.
Ports Status -This submenu contains a table that shows the current port status of the unit (You can not
change the status via this table).
Load Factory Defaults - This option loads default parameter values that were set in the factory, but does
not affect the following parameters: Agent IP Address, Agent Netmask, and Default Gateway. The values
do not take effect until the Save Parameters and Reset option is used (see below).
Software Upgrade - This option transfers the unit into TFTP mode. The unit waits for a TFTP call from
the user. After the call is received the unit will be restarted.
Reset - This option resets the unit. Non port configuration changes are put into effect only after Reset.
Logout - This option logs you out of the unit’s terminal configuration program.

2.7 General Configuration Menu
The General Configuration submenu contains in-band communication parameters for SNMP and Web
management of the unit:
MAC address - The MAC address is set at the factory and cannot be changed.
Agent IP Address - The IP address identifies the unit on the network. The IP address must be unique, and
should be typed in standard dot notation.
For example, 192.115.16.131
Agent Netmask - IP addresses consist of a network portion and a station portion. The Netmask defines
the size of the network portion of the address, and the remaining part is the station number.
Default Gateway - The IP address of a network device that performs the gateway function. Packets with
unknown addresses are sent to the gateway, and the gateway forwards them to their destinations on other
subnets. The gateway device must be on the same subnet as the unit, so the network portion of their IP
addresses should be identical.
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Supervisor/Terminal Password - By default there is no password, and this option can be used to add a
password. The password is used to access this terminal configuration program. In addition, VWMS does
not allow unit parameter changes without this password.

2.8 SNMP Configuration Menu
The SNMP Configuration submenu contains parameters that allow the unit to report to a management
station:
IP Address of Manager - The IP address of the network device where the unit should send traps. Other
network devices can manage the unit, but they do not receive traps.
Read Community Name - The Read Community name of the unit. The management station will receive
responses to GET operations only if the correct Read Community name is used. The default value is
public.
Write Community Name - The Write Community name of the unit. The management station will be able
to use SET operations only if the correct Write Community name is used. The default value is private.
Trap Community Name - The Trap Community name of the management station. The default value is
public.
Send Alert Traps - When this option is enabled, the unit sends traps to the management station(s).
Otherwise, traps are not sent.

2.9 Ports Configuration Menu
The Ports Configuration submenu contains the status parameters of each port in the unit:
10Mbps Ports: This submenu contains parameters of ports 1 to 24 (the 10Mbps ports).
The parameters are:
Port Number (the port who’s status you wish to configure), is Enabled, is in Full Duplex, is in Flow
Control and is in Back Pressure.
10/100Mbps Fixed Port: This submenu contains parameters for port number 25, which is a fixed 10/
100Mbps port.

The parameters are:
Port is Enabled, is in Auto-Negotiation, is Speed 10 Mbps or 100Mbps, is in Full Duplex, is in Flow
Control, and is in Back Pressure.
10/100Mbps Uplink module Port: This submenu contains parameters for port number 26, which is the
uplink port of the unit.
The parameters are the same parameters as in the 10/100Mbps Fixed Port submenu.
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3.0 Installing and Opening VWMS
Overview
This section describes the requirements of the network management station, how to install VWMS, and
how to access the VWMS main window. The methods to use for installing and accessing VWMS depend
upon your particular situation:
If you are using VWMS-Java with a Web browser other than Microsoft Internet Explorer 4.X, proceed to
VWMS for Web Browsers in this section.
If you are using VWMS-Java with Microsoft Internet Explorer 4.X, proceed to VWMS for Explorer 4.X in
this section.
If you are using VWMS-WIN, proceed to VWMS for SNMPc in this section.

3.1 Network Management Station Requirements
Before installing VWMS, check that your network management station fullfils the following requirements.

3.1.1 For VWMS-Java:
Pentium 90 Mhz PC Minimum
32 Mbytes of memory
Windows 95 or 98
Internet browser installed

3.1.2 For VWMS-Win (additional requirements):
Microsoft Java Virtual Machine™ (JVIEW). This application may have been automatically installed after
installing Microsoft Internet Explorer (depending on the chosen options). This file may be downloaded, if
necessary, by accessing the following URL: http://www.microsoft.com/msdownload/java/vm/315x/
msjavx86.asp
Castle Rock SNMPc™ for Windows

3.2 VWMS for Web Browsers
If you are using VWMS-Java with a Web browser other than Microsoft Internet Explorer 4.X, there is no
need for any installation. To open the main VWMS window:
1. Open the Web browser.
2. Open the URL ip_address/VOL-0215.html where ip_address is the IP address of the unit.
For example, 192.115.16.131/VOL-0215.html
3. When prompted, enter the username VOL-0215 and the password. By default there is no password
(leave the password field blank).
The management application loads from the switch, please wait until loading is finished. The main
VWMS window opens (refer to Figure 2 on page 12).

3.3 VWMS for Explorer 4.X
Microsoft Internet Explorer 4.X does not allow you to access the unit by entering the IP address. You
must assign a logical name to the unit. Users of Explorer 4.72 must also activate several Explorer parameters. When these steps are complete, you will be able to open the VWMS main window.

3.4 Assigning a Logical Name to the Unit
If you have a DNS server, you can register the unit’s IP address and logical name on a DNS server.
Otherwise, do the following:
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1. Locate the text file hosts in the Windows directory. For Windows NT, the hosts file is located in the
\winnt\system32\drivers\etc\hosts directory.
2. Append the following line to the end of the hosts file:
ip_address logical_name
where ip_address is the unit’s IP address and logical_name is the name you are assigning to the
device.
For example, 192.115.16.131 switch

3.5 Activating Explorer 4.72 Options
After a logical name is assigned, users of Explorer 4.72 must also do the following:
1. Open Explorer.
2. Open the View menu and choose Internet Options.
3. Select the Custom checkbox. The Settings button becomes available. Press Settings.
4. In the Security Settings window, under Java and Java Permissions, select the Custom checkbox. The
Java Custom Settings button becomes available. Press Java Custom Settings.
5. In the Internet Zone window, select the Edit Permissions tab. Under Run Unsigned Content select
Run in sandbox and under Access to all Network Addresses select Enable. The Internet Zone
window should appear as below.

Figure 1: Explorer 4.X Options
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3.6 Opening the VWMS Main Window
You can now open the VWMS main window:
1. Opening the URL ip_address /VOL-0215.html where ip_address is the IP address of the unit.
For example, 192.115.16.131/VOL-0215.html
2. When prompted, enter the username volition and the password. By default there is no password
(leave the password field blank). The management application loads from the switch, please wait
until loading is finished. The main VWMS window opens (refer to Figure 2 on page 12).

3.7 VWMS for SNMPc
VWMS-WIN works as a vendor add-on to the SNMPc network management platform. VWMS-WIN adds
3M icons to SNMPc, and allows you to access the VWMS management application from SNMPc.

3.8 Installing VWMS on SNMPc
Install VWMS on SNMPc as follows:
1. Insert the VWMS-WIN diskette into the drive.
2. Go to the SNMPc program group, and double click on the Setup icon.
3. On the Type of Installation window, press the Vendor Installation button.
4. Type the path of the diskette drive. For example, a:
5. When self-Extractor window opens click the OK button.
VWMS-WIN software is successfully installed on SNMPc.

3.9 Setting Up the Unit on SNMPc
Each time a 3M unit is added to your network, perform the following steps to setup the 3M unit icon on
the SNMPc network maps:
1. Start SNMPc.
2. Run a network discovery to add the unit to the SNMPc network maps as described in SNMPc
documentation. 3M devices appear on the SNMPc network maps with the proper icons.
3. Click on a new 3M VOL-0215 or VOL-0215 unit icon.
4. Open the Edit menu and choose Edit Object. The Edit Node Attributes window opens.
5. Verify that the community names are correct. Default values are: Read - Public, Write - Private,
Trap - Public.
6. Optionally edit the Node Name. For example, you can change it to 3M switch.
7. Press Change.

3.10 Opening the VWMS Main Window
To open the VWMS main window from an SNMPc network map:
1. Double click on the icon of a 3M device.

3.11 VWMS for HP OpenView™
VWMS-WIN works as a vendor add-on to the HP OpenView™ network management platform.
VWMS-WIN adds 3M icons to OV, and allows you to access the VWMS management application from
the OV main menu and from a popup menu.
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3.12 Installing VWMS on OpenView ™
Before Installing VWMS please check the following software requirements to
ensure a smooth installation:
1. HP OpenView version 5.00 and above is installed and running properly.
2. Microsoft Internet Explorer 4.0 SP1 is installed and running properly.
Install VWMS on HP OpenView™ as follows:
1. Close All HP OpenView NNM sessions.
2. Stop the HP OpenView services From the command line (a DOS prompt) run ovstop and wait for
the program to finish Select: “Start->Programs->Hp OpenView->NNM Services - Stop” from
Windows Start menu.
3. Insert the first VWMS diskette into the drive.
4. Select “Start->Run” from Windows Start menu.
5. Type “a:\setup” press OK and follow the setup instructions.
6. After setup is completed go to OpenView contrib directory and change directory to “3M”
(“\OpenView\contrib\3M”), run the program 3m_install.exe to finish the integration procedure
(this step can take several minutes depending on the size of your OpenView database).
VWMS-WIN software is successfully installed on HP OpenView.

3.13 Opening the VWMS Main Window
There are two options to open the VWMS main window from the OpenView network map:
1. From the main menu
Select a VOL-0215 icon from the OpenView map.
Click on the main menu Tools->3M->VOL-0215/VOL-0215 Management.
2. From a popup menu Select a VOL-0215 icon from the OpenView map.
Right click on the selected object
From the popup menu select 3M-> VOL-0215/VOL-0215 Management.
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4.0 Getting Started with VWMS
Overview
This section introduces the VWMS main window and explains how the main window is used to access the
management options.

4.1 Using the Main Window
The VWMS main window shows the unit’s front panel as it actually appears on the physical unit. The
LEDs are updated each time VWMS polls the unit. Disabled ports have a red “X” drawn over them. Ports
operating at full duplex have an “F” on. To see a brief description of LEDs or ports, simply hold the
cursor over the desired object.

Figure 2: VWMS Main Window of the VOL-0215

4.2 Using the Management Options
All VWMS management options are accessed via the main window. By clicking on a port, you can access
the ports properties, port spanning tree parameters, and port physical status. These options are described
in Configuring Port Parameters on page 27. All other options are accessed via the main menus as described below.

Note
1. You cannot make changes to unit parameters unless the Supervisor password is entered. This is
done using the Passwords option in the System menu.
2. Whenever you make parameter changes, it is recommended to save the settings and then restart the
unit. This is done using the Save Settings and Restart Unit options in the Commands menu.
The following table describes the main menus of the VWMS main window:
Table 1: VWMS Main Menus
Main Menu

Description

Where to Find

System

Setting and entering passwords, and editing
passwords, and editing the unit name.

Setting the System Parameters,
page 14.

Config

Configuring global parameters including
backup mode, configuring SNMP
parameters that designate the management
station(s), Spanning Tree.

Configuring Unit Parameters,
page 15.

Commands

Saving changes and restarting the unit,
restoring default settings, clearing all
counters, Upgrading Software, and
polling now.

Using Global Commands, page 24.

Settings
Hand
Incoming

Adjusting TSView’s polling of the unit.
If the unit generates traps while TSView is
open, a trap window will appear.

Adjusting Polling, page 25.
For more information about
traps and management stations,
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4.3 Handling Incoming Traps
If the unit generates traps while VWMS is open, a trap window will appear. For more information about
traps and management stations, refer to “Viewing the Traps Log”.
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5.0 Setting System Parameters
Overview
This section describes the management options in the System menu of the VWMS main window. These
options are used to set the following system parameters:
Passwords - The password necessary to access VWMS, and the password necessary to change unit
settings.
System Name - The name of the unit that appears at the top of the VWMS main window.

5.1 Setting Passwords
A password is necessary to access VWMS, and a different password is necessary to change unit settings.
To set passwords, select the Passwords option in the System menu of the VWMS main window.

Figure 3: Password Window
The Password window contains the following parameters:
WEB - This is the password used to access VWMS from a Web browser. By default there is no WEB
password. If you type in a password here, you will be prompted for the password the next time you try to
access VWMS.
Supervisor - This password is necessary before you can change unit settings. By default there is no
Supervisor password. You can set the Supervisor password using the terminal configuration program
(refer to last parameter of General Configuration Menu on page 6). If the password is set, you must enter
the password in this field or you cannot change unit settings. However, you can change parameters that do
not affect the unit, such as polling. The Supervisor password is also used to access the terminal configuration program. After setting the Supervisor password, you must save settings and reset the unit (refer to
Using Global Commands on page 24), and then close and reopen the application, for the new password to
be effective.

5.2 Setting System Name
To set the unit name, select the Name option in the System menu of the VWMS main window.

Figure 4: System Name Window
The System Name appears at the top of the VWMS main window, Figure 4.
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6.0 Configuring Unit Parameters
Overview
This section describes the management options in the Config menu of the VWMS main window. These
options allow you to configure the following:
Global Parameters - These are general parameters regarding the unit as a
whole such as basic IP parameters and backup mode.
SNMP Parameters - The parameters that designate the unit's managers, including manager IP addresses
and community strings.
Spanning Tree Parameters - The Spanning Tree algorithm dynamically creates a "tree" through the
network used to efficiently direct packets to their destinations. If the unit Spanning Tree option is enabled,
the unit acts as a node in the tree.
Mail Notification - parameters for mail notification of traps. Given an email address and a trap type, an
email will be sent to the given address
notifying a trap accrued.
VLAN Parameters - VLANs allow the creation of network segments via software (Port Based VLANs).
Unit ports are assigned to VLANs, and ports in different VLANs do not communicate with each other. It
is as if the ports are located on different network devices.

6.1 Configuring Global Parameters
This option lets you configure global unit parameters such as basic IP parameters, backup mode, and
aging time. To configure unit global parameters, select the Global option in the Config menu of the
VWMS main window.

Figure 5: Global Settings Window
The Global Settings window contains the following parameters:
Local MAC Address - The MAC address of the unit. This address is set at the factory and cannot be
changed.
Local IP Address - The IP address identifies the unit on the network. The IP address must be unique, and
should be typed in standard dot notation.
Gateway IP Address - The IP address of a network device that performs the gateway function. Packets
with unknown addresses are sent to the gateway, and the gateway forwards them to their destinations on
other subnets. The gateway device must be on the same subnet as the unit, so the network portion of their
IP addresses should be identical.
Subnet Mask - IP addresses consist of a network portion and a station portion. The subnet mask defines
the size of the network portion of the address, and the remaining part is the station number.
15

Aging Time - How many seconds the address of a learned network device remains on the list of stations
connected to the unit. The address is removed from the list of stations if no frame is received from that
station for the aging time interval. Refer to Viewing the .

6.2 Setting SNMP Parameters
The SNMP Settings window contains manager address and community name parameters. In standard
mode, the unit sends traps to a single designated station, and other network stations with the correct
community names can GET and SET unit parameters. In advanced mode, the unit can send traps to more
than one designated manager, and non-designated stations cannot manage the unit at all. You can view
traps sent by the unit to the management station using the Traps Log, refer to Viewing the Traps Log.
To set SNMP parameters, select the SNMP option in the System menu of the VWMS main window.

Figure 6: SNMP Setting Window
The SNMP Setting window contains the following parameters:
Host IP Address for Traps - The IP address of the network device where the unit should send traps.
Other network devices can manage the unit, but they do not receive traps.
Read Community - The Read Community name of the unit. The management station(s) will receive
responses to GET operations only if the correct Read Community name is used. The default value is
public.
Write Community - The Write Community name of the unit. The management station(s) will be able to
use SET operations only if the correct Write Community name is used. The default value is private.
Trap Community - The Trap Community name of the management station. The default value is public.
When Advanced mode is activated, this field is grayed-out since manager trap communities are set using
the Advanced window (see below).
Send Alert Traps - When this option is enabled, the unit sends traps to the management station. Otherwise, traps are not sent.

6.3 Configuring Spanning Tree Parameters
The Spanning Tree algorithm dynamically creates a “tree” through the network used to prevent loops in
the network. If the unit Spanning Tree option is enabled, the unit acts as a node in the tree. Several of the
Spanning Tree parameters can be configured using this option.
Other Spanning Tree parameters can be viewed; refer to Viewing Spanning Tree Status on page 21.
Spanning Tree cannot be used when VLANs or back up mode are used.
To configure the Spanning Tree parameters for the unit, select the Spanning Tree option in the Config
menu of the VWMS main window.
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Figure 7: Spanning Tree Parameters Window
The Spanning Tree Parameters window contains the following parameters:
Enable Spanning Tree - When this option is enabled, the unit supports Spanning Tree and acts as a node
in the “tree”. When the Spanning Tree option is disabled, the rest of the options in this window are
irrelevant.
Priority - The first two octets of the Bridge Identifier used by the Spanning Tree algorithm to identify the unit.
Hello Time - How many seconds between configuration bridge PDU transmissions by the ports of this
unit when it is the root of the spanning tree or trying to become so.
Forward Delay - How long the unit stays in each of the Listening and Learning states, which precede the
Forwarding state. In addition, when a topology change has been detected and is underway, this parameter
is used to age all dynamic entries in the Forwarding Database.
Max Age - How many seconds learned Spanning Tree information is kept before being discarded.

6.4 Configuring Mail Notification Parameters
This option allows you to send an email massage whenever a specific kind of trap occurred. There are two
families of traps; Control traps which are the cold start and the Authentication Failure traps and Link
Status traps which are the link up / down traps. For each inserted email address you can send a “control
trap occurred” massage and/or a “link up/down” massage.

6.5 Configuring VLAN Parameters
VLANs enable network segmentation by port-grouping. Unit ports are assigned to VLANs, and ports in
different VLANs do not communicate with each other. It is as if the ports are located on different network
devices. VLANs and Spanning Tree cannot be used at the same time.
To configure the VLAN parameters for the unit, select the VLAN option in the Config menu of the
VWMS main window.
The VLAN Configuration window displays each port under the VLAN it belongs to. To move a port to a
different VLAN, simply type the VLAN number next to the port. In the example above there are several
VLANs as follows:
VLAN 0 - Ports 11, 13, 14, 15, and 24. VLAN 0 means the port is available to all VLANs.
VLAN 1 - Ports 1, 2, 9, 18, 19, 23, 25, and 26.
VLAN 6 - Port 5.
VLAN 7 - Port 6.
VLAN 8 - Ports 3, and 22.
VLAN 9 - Ports 12.
VLAN 77 - Ports 7, 8, 20 and 21.
VLAN 255 - Ports 4, 10, 16, and 17.
17

Figure 8: Mail Configuration Window

Figure 9: VLAN Configuration Window
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7.0 Viewing Status Reports
Overview
This section describes the management options in the Reports menu of the VWMS main window. These
options allow you to view the following reports:
Unit Description - A general description of the unit.
Traps Log - A report of the traps received by the management station.
Learning Table (Fdb) - A report of the network devices currently connected to the unit ports.
Spanning Tree Report (STP) - A report of the current Spanning Tree parameters of the unit. The Spanning Tree algorithm dynamically creates a “tree” through the network used to prevent loops in the network. The unit supports Spanning Tree and acts as a node in the tree.
Global Status - A report of the current status of all ports.

7.1 Viewing Unit Description
The Description window contains general read-only information about the unit.

Figure10: Description Window for VOL-0215
To view a description of the unit, select the Description option in the Reports menu of the VWMS main
window. The Description window contains the following parameters:
Device Type - The type of unit.
Software Revision - The revision of the software currently resident on flash memory.
Time Since Last Restart - The number of days and hours since the unit was last reset.

7.2 Viewing the Traps Log
The Traps Log lists the traps that the unit sent to the management station you are using. If the station you
are using has not been defined as a management station, the Traps Log will be empty. Management
stations are defined using the SNMP window, refer to Setting SNMP Parameters.
To view the Traps Log, select the Traps Log option in the Reports menu of the VWMS main window.
The Traps Log window shows the following parameters for each trap:
Date and Time - The date and time that the trap was generated.
Description - A brief description of the event that caused the trap.
If VWMS is open on the management station (but SNMPc) while a trap is generated, a Trap window
appears. The trap is also entered in the Traps Log.
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Figure 11: Fdb Window

Figure 12: Trap Window

7.3 Viewing the Learning Table
The Fdb (Forwarding Data Base) Log lists the network devices connected to each unit port. The addresses
of many of the devices are learned when they send or receive packets through the port. The amount of
time learned address remain on the list when they are not active is defined using the Aging Time parameter (refer to Configuring Global Parameters).
To see the Learning Table, select the Fdb Table option in the Reports menu of the VWMS main window.
The Fdb window shows the following parameters for each device:
MAC Address - The MAC address of the network device.
Port - The unit port to which the device is connected.
VLAN number - The VLAN number the port belongs to.
All the network device that were added to the list are of status learned.
Learned - The network device was learned when data was sent through the port, to or from the device.
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Figure 13: Traps Log Window

7.4 Viewing Spanning Tree Status
The Spanning Tree algorithm dynamically creates a “tree” through the network used to prevent loops in
the network. The unit supports Spanning Tree and acts as a node in the tree. To view current Spanning
Tree parameters, select the STP Status option in the Reports menu of the VWMS main window. Some
Spanning Tree options can be configured)

Figure 14: Spanning Tree Report Window
The Spanning Tree Report window contains the following Spanning Tree parameters:
Designated Root - The MAC address of the network device which functions as the starting point of the
Spanning Tree.
Topology Change - The number of times the Spanning “tree” has been reconfigured since the unit was
last reset. The “tree” reconfigures itself automatically in response to network changes.
Root Cost - How much it “costs” to get from this unit to the designated root. The lower the cost, the more
preferred this path.
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Root Port - The unit port with the lowest “cost” to get to the designated root.
Max Age - How many seconds learned Spanning Tree information is kept before being discarded.
Hello Time - How many seconds between configuration bridge PDU transmissions by the ports of this
unit when it is the root of the spanning tree or trying to become so.
Hold Time - Length of time in seconds during which no more than two Configuration bridge PDUs are
transmitted by the unit.
Forward Delay - How long the unit stays in each of the Listening and Learning states, which precede the
Forwarding state. In addition, when a topology change has been detected and is underway, this parameter
is used to age all dynamic entries in the Forwarding Database.

7.5 Viewing Global status
The Global Status shows the status of all ports in the unit. The status includes the following parameters:
Link - Whether the link is currently up. If checkbox is marked this port’s link is up.
Disable - When marked, the port is disabled and does not receive or transmit information.
Duplex - Is port, if link is up, receiving or transmitting in Full or Half Duplex.
Partition - Whether the port is currently auto partitioned.
Back Pressure - A technique for ensuring that a transmitting port does not overwhelm a receiving port
with data. When the buffers allocated to a port exceed a certain size a “Jam” massage will be sent to the
transmitting port so that transmission will be stopped. Back Pressure is available only if the port transmits
or receives in Half Duplex.
Flow Control - The same as Back Pressure but for Full Duplex.
For the fixed 10/100Mbps port and the uplink module the following parameters are added:
Speed - Whether current receive or transmit speed is 10Mbps or 100 Mbps.
AutoNeg. - When this option is enabled, the port automatically finds the highest speed that can be
supported on the link.
This table is divided into three dialog boxes.The first one for ports 1 to 12, the second for ports 13 to 24
and the last for ports 25 and 26.
The following buttons are available at the bottom of the screen:
Close - For closing the window. No changes in port configuration can be made via this table.
Refresh - Reads all data again and refreshes the window.
Next - This button opens the next Window of Global Status. You can open each dialog box independently
via menu. The Next button appears only in the first and second dialogboxes
Prev. - This buttons opens the previous window of Global Status. The button appears only in the second
and third dialog boxes.
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Figure 15: The first Global Status Report Window

Figure 16: The second Global Status Report Window

Figure 17: The last Global Status Report Window
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8.0 Using Global Commands
This section describes the management options in the Commands menu of the VWMS main window.
These options implement the following global commands:
Restart Unit - This command is used to reboot the unit. This has the same effect as detaching and reattaching the unit power cable. Remember to use this command after you save changes to parameters.
Restore Default Setting - This option loads default parameter values that were set in the factory, but
leaves the following terminal configuration parameters as they are: Local Agent IP Address, Agent Subnet
Mask, and Default Gateway IP Address. Restored parameters are implemented at next polling.
Clear All Counters - This command resets unit counters to zero.
Upgrade Software - This command switches the unit to FTP mode. The unit now waits to a remote FTP
call.
Poll Now - This command causes VWMS to immediately poll the unit for current status information and
refresh the main window. In general, VWMS polls the unit at set time intervals as configured in the
Polling window (refer to Adjusting Polling).
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9.0 Adjusting Polling
This section describes the Polling option in the Settings menu of the VWMS main window.
VWMS polls the unit at regular intervals. At each poll, the latest unit status information is sent to VWMS,
and the front panel on the VWMS main window is refreshed.

Figure 18: Polling Settings Window
The Polling Settings window contains the following parameters:
Enable Polling - When this option is enabled, VWMS polls the unit at the specified time interval.
Polling Interval - How often (in seconds) VWMS polls the unit.
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10.0 Configuring Port Parameters
Overview
This section describes the management options available when you click on a port. These options provide
the following information about the selected port:
Port Properties - General port properties such as enable/disable and link mode.
Port Spanning Tree Settings - Spanning Tree parameters of the particular port.
Port Statistics - Various statistics and counters regarding the port.

10.1 Configuring Port Properties
To configure the properties of a particular port, click on the port in the VWMS main window with the
right mouse button.
Note: The Port Properties window contains different parameters depending on the communication
speed supported by the port.

Figure 19: Port Properties Window of a 10/100 Mbps Port
The Port Properties window for a 10/100 Mbps port contains the following parameters:
Port Enable - When this option is enabled, the port can function normally. When this option is disabled,
the port is disabled and does not receive or transmit information.
Auto Negotiation - When this option is enabled, the port automatically finds the highest speed that can
be supported on the link. It is recommended to use auto negotiation unless the device connected to the
port does not support it. If auto negotiation is enabled, the other mode settings are grayed-out.
100Mbps Full Duplex - When the Full Auto Negotiation option is disabled, the option can be used to set
the link mode to 100Mbps Full Duplex.
100Mbps Half Duplex - When the Full Auto Negotiation option is disabled, the option can be used to set
the link mode to 100Mbps Half Duplex.
10Mbps Full Duplex - When the Full Auto Negotiation option is disabled, the option can be used to set
the link mode to 10Mbps Full Duplex.
10Mbps Half Duplex - When the Full Auto Negotiation option is disabled, the option can be used to set
the link mode to 10Mbps Half Duplex.
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Back Pressure - A technique for ensuring that a transmitting port does not overwhelm a receiving port
with data. When the buffers allocated to a port exceed a certain size, a “Jam” massage will be sent to the
transmitting port so the transmission will be stopped. Back Pressure is available only if the port transmits
or receives in Half Duplex.
Flow Control - The same as Back Pressure but for Full Duplex.
Status - The current communication mode over the link.
Port Description - A brief description of the port.
The Port Properties window of other ports may appear different and may not contain all the above parameters.

10.2 Configuring Port Spanning Tree Parameters
To configure a port’s Spanning Tree parameters, first click on the port in the VWMS main window, and
then press the STP button at the bottom of the Port Properties window.

Figure 20: Port Spanning Tree Settings Window
The Port Spanning Tree Settings window contains the following Spanning Tree parameters for the port:
Priority - Priority of the current port (see RFC 1493 for detailed explanation).
Path Cost - The contribution of this port to the path cost of paths towards the spanning tree root which
include this port. The Spanning Tree “cost” of going through this port.
State - The port’s current state as defined by the Spanning Tree Protocol. Possible states include disabled,
blocking, listening, learning, forwarding, and broken.
Designated Root - The MAC address of the network device which functions as the root of the Spanning
Tree.
Designated Cost - The path cost of the Designated Port of the segment connected to this port.This value
is compared to the Root Path Cost field in received bridge PDUs.
Designated Bridge - The Identifier of the designated bridge for this port’s segment.

10.3 Viewing Port Statistics
To view a port’s statistics, right-click on the port in the VWMS main window.
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Figure 21: Port Detailed Statistics Window
The Port Detailed Statistics window contains the following counters:
Note: The Port Detailed Statistics window contains different counters depending on the type of the
port. Not all counters below appear for each port.

10.3.1 Received
Bytes - Number of bytes received.
Frames - Number of frames received.
Multicast Frames - Number of Multicast frames received.
Broadcast Frames - Number of Broadcast frames received.
Frames =64 bytes - Number of frames received and transmitted of length 64 bytes.
Frames 65 - 127 bytes - Number of frames received and transmitted of length between 65 bytes and 127
bytes.
Frames 128 - 255 bytes - Number of frames received and transmitted of length between 128 bytes and
255 bytes.
Frames 256 - 511 bytes - Number of frames received and transmitted of length between 256 bytes and
511 bytes.
Frames 512 - 1023 bytes - Number of frames received and transmitted of length between 512 bytes and
1023 bytes.
Frames 1024 - 1522 bytes - Number of frames received and transmitted of length between 1024 bytes
and 1522 bytes.
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10.5 Receiving Errors
CRC or Alignment (Frames with CRC or Alignment errors) - Number of frames received that contain
CRC or alignment errors.
Frames > 1522 with bad CRC (Jabber) - Number of frames received, with length greater than 1522
bytes, which have a bad CRC (jabber) error.
Frames > 1522 - Number of frames received with length greater than 1522 bytes.
Frames < 64 - Number of frames received with length less than 64 bytes.
Frames with Rx MAC error - Number of frames received that have a reception MAC error.
Fragments - Number of fragments received.
Dropped Packets - Number of packets that were dropped.

Collisions
Received and Transmit Collisions - Total Number of collisions that occurred during reception and
transmission.
Received and Transmit Late Collisions - Number of late collisions that occurred during reception and
transmission.

Sent
Frames Sent - Number of frames sent.
Bytes Sent - Number of bytes sent.
Press Clear to reset the counters. Counters are also reset when the device is reset or when the Clear All
Counters option in the Commands menu is used. Press Refresh to load the latest counter values from the unit.
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Appendix A Troubleshooting
This appendix presents common problems and describes their solutions. The problems begin with a P, and
the solutions begin with an S.
P: The Configuration Terminal main menu does not appear.
S: Verify that the cable length does not exceed 10 meters, and the pin-out is as described in the Installation Guide. In addition, verify that the terminal is set to 9600 baud, 8 data bits, 1 stop bit, no
parity, and no flow control.
P: VWMS does not come up on the management station.
S: Wait patiently; it can take a while for the program to load from the device. If after a long time it still
does not come up, verify that the Basic IP Parameters are set properly (refer to General Configuration Menu). In addition, verify that the management station fulfills the requirements (refer to
Network Management Station Requirements) and the software has been properly installed (refer to
Installing and Opening VWMS).
P: VWMS comes up, but I can’t view a device.
S: Verify that the device community names are properly set (refer to Setting SNMP Parameters on
page 16).
P: My password is not working.
S: Remember that there are two passwords; one to access VWMS and one to change parameters (refer
to Setting Passwords on page 15). P: VLANs are not working. S: Be sure VLANs are enabled
(refer to Configuring VLAN Parameters)
P: A port is not working.
S: Check that the port is not disabled (refer to Configuring Port Properties).
P: The Network Management Station is not receiving traps.
S: Verify that the Manager IP address is properly set (refer to Setting SNMP Parameters on page 16).
P: I really messed up the configuration.
S: Reload the default factory values using the configuration terminal (refer to Main Menu) or using
VWMS (refer to Using Global Commands). Be aware, this action changes the switch IP address.
P: The Port Properties window for my port is different than I expected.
S: The Port Properties window contains different parameters and buttons depending on the communication speed supported by the port.
P: The software upgrade did not work.
S: Carefully follow the instructions in Troubleshooting Software Upgrade.
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Appendix B Upgrading Software
Overview
VWMS software can be upgraded to reflect changes in the MIBs and enhancements to the software. The
software is sent to you on diskette. You need to download the software to the unit’s Flash memory using TFTP.

Before File Transfer
Before file transfer, perform the following preparatory tasks:
1. Copy the file VOL-0215.IMG from the upgrade diskette to your hard disk.
2. Connect your workstation network interface to one of the switch ports. The connection can be
direct, or via other network devices such as hubs and switches. You can use the Ping command
from your workstation, to verify successful connection with the unit.
3. It is recommended that you disconnect all unessential devices from the unit to minimize interference
during the transfer. Do not run network management software during the transfer.
4. Choose the “Upgrade software” option in the unit’s main menu. The unit is now in TFTP mode i.e.
it will reset and wait for a TFTP transmission.
Note: If after 10 minutes. the unit didn’t receive a TFTP call, or if the unit was booted while waiting
for a TFTP call, it will restart using the last TPS_IMG file.

Transferring the File
To transfer the file from your hard disk to the unit’s flash memory:
1. Start TFTP client application on your workstation.
2. Connect to the unit. For example, with some TFTP programs you will open the File menu, choose
Connect, and then type the unit’s IP address.
3. Transfer the local file tps.img to a remote file, named: tps_img. The transfer must take place in
binary mode. For example, with some TFTP programs you will open the File menu, choose Put,
select binary mode, type tps_img, and press Enter.
File transfer is complete. The next time the unit is reset, the new software takes the place of the old and
runs.
You can view the Description window (refer to page Viewing Unit Description) to verify that the new
software revision is displayed in the active flash.

Troubleshooting Software Upgrade
If software upgrade was unsuccessful, try the following:
1. Verify that the tasks described in Before File Transfer were done.
2. Verify that you transferred to the file name tps_img
3. If the file transfer stopped in the middle, try again.
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